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Email Quotas and Restrictions

Email Quotas and Restrictions
The following restrictions apply to faculty and staff email account:

« Individual emails cannot be greater that 35 MB including attachments. Faculty and staff are restricted to less than 1000 recipient emalil
addresses per email and 5000 recipients per day. Students are restricted to less than 300 emails a day.

« Blocked file extensions: inf, ink, scf, msp, cpl, msh2xml, msh1xml, mshxml, msh2, msh1, msh, psc2, psc1, ps2xml, ps1xml, ps1, wsh wsc, wsf,
ws, jse, vbs, vb, cmd, jar, hta, msi, scr, bat, Macros, com, js, exe

If you need to email a file with one of these extensions, you must change the extension to .txt and instruct your recipient to change it back to the original
once they receive it. To change a file extension refere to the following instuctions:

« Make sure you can see file exentions. If you see a period followed by two three or four letters at the end of your file name (e.g., .doc), then you
can see them. If you don't see the extension you need to turn on the ability to see them. To turn this on:
o Click on My Computer.
o Click on the Tools menu.
o Choose Folder Options.
o Click on the View tab.
o Scroll down to Hide Extensions for Known File Types
o Uncheck Hide Extensions for Known File Types
Locate the file you want to attach to your email.
Select it by clicking on it once (don't open it). It should be highlighted.
Press F2 (rename) on your keyboard.
Move your cursor over to the file extension and change it to .txt
Press Enter on your Keyboard

You can now safely send the attachment over email. Remember to instruct your recipient to change the extension back to the original.
Email Archiving and Managing Storage Space

Users who email large files or have long standing accounts may eventually reach a storage limit. ) )

To address this, Outlook has an Archive feature that will free up space by archiving items older Mailbox selection pane
than a selected number of years. Additionally, deleted items and junk mail are automatically

archived. Archived material still appears in Outlook search results.

To archive email, right-click any folder in Outlook, choose Assign Policy and select either the one
year, three year, or five year policy. Each of these will auto-archive items within the selected folder
based on their age, archiving items older than one, three or five years respectively. An Online
Archive folder will contain the archived email, but will not count against your quota.

The Online Archive mailbox comes with a default capacity of 100 GB (in addition to your 50 GB
main mailbox quota) and will preserve the folder structure of archived items. For example, items
archived from an Inbox, Deleted Items, and Junk Mail folders that are older than five years appear
in the archive folder similarly structured as shown in the image below.

When you search your mailbox using the search bar in Outlook, your Online Archive will

~ & In-Place Archive -lohnso... automatically be included within the results. You can find more information about using the Online
Archive mailbox folder in Outlook here: Manage email storage with online archive mailboxes -
B3 Archive Microsoft Support

> BJ Deleted ltems

> B3] Inbox

£ Junk Email

£ Sent ltems
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https://nam04.safelinks.protection.outlook.com/?url=https%3A%2F%2Fsupport.microsoft.com%2Fen-us%2Foffice%2Fmanage-email-storage-with-online-archive-mailboxes-1cae7d17-7813-4fe8-8ca2-9a5494e9a721%23ID0EFD%3DOutlook_for_Windows&data=05%7C02%7CPalumboM%40easternct.edu%7Ce5af9c027ea84cb697c008dcd35b266a%7C00bc4ae8576c45e3949d4f129d8b670a%7C0%7C0%7C638617635657348533%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=%2BnzgjSwlOdMZNGYTn26jla919XyeH7nLL%2BbL9dlBlSg%3D&reserved=0

Installing Adobe Acrobat DC and Creative Cloud Applications

All university-owned Windows computers have the main Adobe Creative Cloud application installed, which manages the individual Adobe
applications. However, due to the size, the standard Eastern package only includes some of the individual applications. If the application you need is
not on your machine, you may download and install it from the Adobe Creative Cloud Application using the steps below.

Adobe Applications include the following:

Acrobat DC
Aero (Beta)
After Effects
Animate
Audition
Bridge
Camera Raw
Character Animator
Dimension
Dreamweaver
llustrator
InCopy
InDesign
Lightroom
Lightroom Classic
Media Encoder
Prelude
Premiere Rush
XD

Photoshop
Premiere Pro

Installing the Main Creative Cloud Application for Home Use Installation

If you are trying to get Adobe applications for home use, you will first need to download and install the main Creative Cloud Application from the
following link and then follow the rest of the instructions:

NOTE: These products are provided to faculty and staff at no cost to them. If during the process, you are prompted to pay for anything, then you
have made an error.

Link to download the main Creative Cloud Application (Home Use Installation Only): https://creativecloud.adobe.com/apps/download/creative-cloud

Instructions for Eastern-owned machines or home use machines after installing the main Creative
Cloud Application:

1. Launch the Creative Cloud Application from your Start Menu
2. Enter your email address and choose Company or School Account when prompted
3. Enter your email address as the username and your Eastern Email password whenever prompted.

4. Click on Apps to see the list of Apps you can download and install.
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https://creativecloud.adobe.com/apps/download/creative-cloud

Low Battery Warning Error on a Desktop

Low Battery Warning Error on a Desktop PC

Previous instructions to remove the low battery warning also removed the automatic shut-down feature of the pc. When you chose to shut down the pc,
rather than shutting down, you'd get a message saying, "it's now safe to shut down your pc."

These are revised instructions to (a) turn back on the shut-down feature and (b) remove the low battery warning message.
IMPORTANT: These instructions require one or more restarts. Please print these instructions first.

Part 1: Re-enable the Advanced Power Management Option

« Go to Start.

« Go to Settings.

« Go to Control Panel.

« Go to Power Options.

« Go to the APM tab. The enable box should be checked. If it's not, check it. This may bring back the low battery warning message after a couple
of restarts, but will also bring back the shut down function.

« Click ok and close all open windows.

Part 2: Update the BIOS

« Shut down your PC.

« After it's completely shut down, restart the machine, but press the F10 button (press it several times) as it's starting up. If the Windows 2000
screen comes up, you were too late and need to shut down and try again.

« You should get either a screen that says keyboard error (press F10 again to enter setup) or you will go directly into setup.

« Once in setup, highlight English and press enter.

« Using the arrow keys move the cursor to the right to the Power section.

« Highlight Energy Saver and press enter.

« Use the right arrow key to change it from Disable to Advanced.

« Press the F10 key to accept.

« Using the arrow keys move the cursor to the left to the File menu and highlight Save Changes and Exit.

« Press Enter.

« Press F10 when it asks if you are sure you want to make changes.

Your computer should re-start normally. After it restarts, the low battery warning will be removed, and the automatic shutdown feature will be restored.
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Software Center (PC) Self Service (Mac and iOS) - How To Self-Install Programs

NOTE: These instructions are only for Eastern owned PC desktops and Mac products. If you have an Eastern owned PC laptop, please fill
out the Software Request Form in_Article 221: Requesting Software Purchases and Installations in Offices, Computer Labs, and Classrooms

The Software Center is a program on your PC that allows you to receive software and updates from ITS. It enables us to keep you up to date and
allows you to install certain software yourself. Mac users have a different application for this purpose called Self Service.

On a PC:

« Click the search icon on the Windows search bar n
Start typing the words: Software Center
« Click on Software Center

Best match

. Software Center
w App

« Select the application you would like to install from the list, and then click the Install button
« The status will change to Installed once the installation is completed. You can now use your program

On a Mac and iOS:

« Using the search tool n in the upper right corner, search for the Self Service application. From the search result, click the Self Service
icon to launch the application.

« If prompted, enter your username and password. Your username is the part of your Eastern email before the @easternct.edu, not your full
email.

« Locate or search for the application you want to install.

« Click Install under the logo for the application

« The status will change to reinstall when the installation is completed. You can now use the application.
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https://easternct.makekb.com/entry/221/

Recover a File or Folder Deleted from the Z-Drive

The following instructions require that you log into a Windows computer on the network at Eastern:

PCs

Go to the start menu and click on Computer.

Right-click on the Z-Drive if the file was in the main directory. If the file was in a subfolder, right-click the subfolder.

Click Properties.

Click on the Previous Versions tab, then highlight the previous version in which you wish to pull the previous document from.
Click Open. A window will appear showing the contents of the version of that folder.

Highlight the file you want to recover.

Right-click the file and select Copy.

Open a new Windows Explorer window. Find the file location in which you wish to put the copied folder.

Right-click inside the folder and select Paste.



Workaround fix for missing OneDrive link on lectern computers
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Thank you to those who reported the missing OneDrive link on the lectern computers. We are actively working to identify the source of the issue and
implement a resolution.

Workaround Steps
We've identified a workaround. Here are those steps.

1) Locate the Search tool in the toolbar in bottom left hand of your screen. Start typing OneDrive.
2) Once the results start populating, find the OneDrive application icon. Click the icon to launch the OneDrive application. It might seem like nothing

happens, this is expected behavior.
I

All Apps Documents Web More =
°  Best match

F OneDrive
App
? Settings 3
OneDrive
& Automatic file downloads privacy App
settings

Ransomware protection .
1 Open
Search the web
Run as administrator
£ onedrive - See more search results i .
Open file location

£ onedrive login Pin to Start

onedrive download Pin to taskbar

onedrive settings Uninstall
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3) On the toolbar in the bottom right of the screen, locate the system tray chevron. Click to expand and access the system tray.
4) Once you've expanded the system tray, click the blue cloud OneDrive icon.

Clickythe
©nebrivelicon:

4

5) On the resulting window, click the help and setting cog in the upper right hand corner.
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@ OneDrive isn't connected o 3
. Help & Settings
Click the cog to
acces the
OneDrive
settings

® st Sunny

6) Click Settings. (Note if you see an Updating OneDrive message, ignore it and continue with these steps)

& OneDrive isn't connected

Settings

View online
Manage storage
Help o

Quit Onelrive

(

Updating OneDrive

7) On the resulting window, click the Account tab.
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& Microsoft OneDrm

Mare inFo

Terms of use

Third party notices

© 2022 Microsoft Corpor@tion. All rights reserved.

OneDrive Device ID

£579a0f3-be3e-3570-ee4e-2537ddoc57  Copy to dipboard

Click

Account tab

8) From the Account tab, Click Add an account.

& Microsoft OneDrive

Settings  Account  About

OneDrive

You don't have an account connected. To
connect an account, select "Add an account” 3N accoun

and then sign in.

Unlink this PC

Click

Add an account

oK || Cancel

T

9) Proceed with to Set up OneDrive by authenticating with your Eastern credentials. Click Sign In.
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& Microsoft OneDrive

Set up OneDrive

Put your files in OneDrive to get them from any device.

Email address

username@easternct.edu

Follow the prompts and click the blue buttons to progress through the setup. (Next, Continue & Next)

@ Microsoft OneDrive

Your OneDrive folder

Add files to your OneDrive folder so you can access them from other devices and still
have them on this PC.

Your OneDrive folder is here
CAUsers\palumbom\OneDrive - Eastern Connecticut State University

Change location

X

@ WMicrosoft OneDrive

Back up your folders

Selected folders will sync in OneDrive - Eastern Connecticut State University. New and
existing files will be added to OneDrive, backed up, and available on your other devices
even if you lose this PC. Learn more.

° ) o
L 3
- = o
Desktop Documents Pictures.
T1KB 0KB 1KB

Space left in OneDrive after selection: 863 GB

X

@ Microsoft OneDrive

To

Get to know your OneDrive

add items, drag or move them into the OneDrive folder.

| [
\k‘n

“ | S w—

Once the process is complete, you should be able to access your OneDrive from the File Explorer navigation pane.

= | File Explorer
Home Share | 4

A | # s Quic

#F Quick access
Documents
‘ Downloads
[&] Pictures
J'S Music

LRGN

one-drive
B videos

@ OneDrive - Eastern

& This PC

:_ﬂ' Metwork

& Micre
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